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[bookmark: _Toc536271576][bookmark: _Toc536271853][bookmark: _Toc536271871][bookmark: _Toc3538726]Ćwiczenie 5 – Przepływ w kanale zakrzywionym
[bookmark: _Toc536271577][bookmark: _Toc536271854][bookmark: _Toc536271872]Zaawansowane funkcje programu Ansys SpaceClaim. Generowanie automatycznej siatki numerycznej. Wpływ zagęszczenia siatki numerycznej na wyniki. Symulacja przepływu przez zakrzywiony kanał w Ansys CFX. Opracowanie wyników w Ansys CFD Post.
[bookmark: _Toc3538727]Opis problemu
	a)
	b)

	[image: ]Woda
w = 1 m/s

	[image: ]


[bookmark: _Ref1222726]Rys. 1. Warunki brzegowe dla przepływu przez zakrzywiony kanał a) widok, b) przekrój

Na Rys. 1 przedstawiono uproszczony kanał przepływowy składający się z dwóch prostopadłych otworów o średnicy 8 mm. W kanale przepływa woda z prędkością w = 1 m/s. Głównym zadaniem jest obliczenie spadku ciśnienia wywołaną stratą miejscową.

[bookmark: _Toc3538728]Cele ćwiczenia
· Edycja geometrii w module Ansys SpaceClaim – ekstrakcja objętości płynu na podstawie geometrii ciała stałego (solid), wyciągnięcie kanału
· Generowanie automatycznej siatki numerycznej
· Zastosowanie jednocześnie dwóch różnych siatek numerycznych: o elementach tetragonalnych i heksagonalnych
· Wykonanie symulacji numerycznej wody w uproszczonym kanale zakrzywionym przy wykorzystaniu Ansys CFX
· Opracowanie wyników za pomocą Ansys CFD Post
· Sprawdzenie wpływu zagęszczenia siatki na wyniki
[bookmark: _Toc3538729]Instruktaż wykonania ćwiczenia
1. [bookmark: _Toc3538730]Włączanie Ansys Workbench
· Włącz Ansys Workbench przez Menu Start > Wszystkie programy > ANSYS 19.2 > Workbench 19.2
[image: ]
2. [bookmark: _Toc3538731]Zapisywanie projektu
Dobrą praktyką jest aby zapisywać każdy projekt w oddzielnym katalogu. Dodatkowo zaleca się nie używania w nazwach katalogów i plików polskich znaków, spacji i znaków specjalnych (np. @#$%^& itp.).
· Utwórz katalog o nazwie Cw5 i skopiuj do niego plik elbow.stp, który został dołączony do ćwiczenia
· W Workbench zapisz nowy projekt o nazwie Cw5FlowInElbow w katalogu Cw5 za pomocą File > Save as
[image: ]
3. [bookmark: _Toc3538732]Importowanie geometrii do Ansys SpaceClaim
· W oknie po lewej stronie w panelu Component Systems kliknij lewym przyciskiem myszy (LPM) na Mesh i przeciągnij do panelu Project Schematic po prawej stronie
[image: ]
· Klikając prawym przyciskiem myszy na Geometry wybierz Import Geometry a następnie Browse
[image: ]
· Wybierz plik elbow.stp który został dołączony do plików potrzebnych do wykonania tego ćwiczenia. Pamiętaj, aby jako rodzaj pliku wybrać typ STEP
 [image: ]
4. [bookmark: _Toc3538733]Tworzenie geometrii płynu na podstawie brył typu solid
SpaceClaim jest to narzędzie do generowania geometrii. W tym ćwiczeniu zapoznasz się z dalszymi możliwościami edycji geometrii w SpaceClaim.
· Aby otworzyć SpaceClaim kliknij dwukrotnie LPM na komórkę Geometry
[image: ]
· Na ekranie pojawi się interfejs graficzny programu SpaceClaim z widoczną geometrią. 
[image: ]
· W celu obrotu modelu naciśnij środkowy przycisk myszy (SPM) i porusz myszą
· W celu przesunięcia modelu wciśnij SPM a następnie klawisz Ctrl i przesuń mysz
· W celu przybliżenia lub oddalenia widoku naciśnij SPM a następnie klawisz Shift i przesuń mysz. Ten sam efekt można uzyskać za pomocą obracania SPM
· Dodatkowo kontrolki ruchu znajdują się w zakładce Design 
[image: ]
Częstym przypadkiem jest importowanie brył trójwymiarowych, które zawierają materiał ścian danego przedmiotu. Bryły te powstają na podstawie dokumentacji technicznej danego urządzenia. Są one dogodne do analizy wytrzymałościowej (MES – metoda elementów skończonych) i po zaimportowaniu do SpaceClaim nadają się do bezpośredniego generowania siatek numerycznych. Jednak w przypadku symulacji CFD (Computational Fluid Dynamics) zagadnienie jest odwrotne – do przeprowadzenia symulacji zwykle nie są potrzebne bryły reprezentujące ciało stałe (wyjątkiem są zagadnienia conjugate heat transefer lub uwzględniające przewodzenie ciepła w ciele stałym), ale bryły płynu, które są zawarte wewnątrz powierzchni tworzących ścianki danego urządzenia. W analizowanym przypadku importowana geometria zawiera jedynie ścianki kanału przepływowego. W celu przeprowadzenia analizy przepływowej należy najpierw uzyskać obszar płynu co jest przedstawione poniżej. 
· W Ansys SpaceClaim wybierz zakładkę Prepare a następnie Volume Extract
[image: ]
· Kliknij ikonę Select Edges w celu wybrania krawędzi, które stanowią brzeg bryły płynu i wybierz 2 krzywe podświetlone na żółto na rysunku poniżej

 [image: ]

· Następnie wybierz ikonę Select Seed Face i wybierz jedną ze zwilżanych przez płyn powierzchni (np. zaznaczona niebieska powierzchnia)
[image: ] [image: ]
· W celu wygenerowania bryły płynu wybierz [image: ]
· W pojawia się nowa bryła o nazwie Volume (zobacz drzewo systemowe)
[image: ]
· Do dalszych analiz potrzebna jest jedynie bryła płynu, więc odznacz element PartBody. Widoczna pozostaje tylko bryła płynu.
[image: ] [image: ]
· Odznacz i wyłącz z dalszych analiz elementy PartBody. Elementy, które nie zostaną wzięte do dalszych analiz oznaczane są znaczkiem[image: ]
[image: ]
 [image: ]
W analizowanym przypadku powierzchnie walcowe o większej średnicy mają stosunkowo niewielką długość co powoduje, że powierzchnia wlotowa i wylotowa kanału są blisko odpowiednio zwężenia i rozszerzenia kanału. Podczas obliczeń może to powodować niestabilność algorytmu obliczeniowego (solveru) ze względu na możliwość pojawienia się stref recyrkulacji w pobliżu przewężenia i rozszerzenia kanału. Zaleca się, aby w miarę możliwości lokalizować powierzchnie brzegowe typu wlot/wylot jak najdalej od stref recyrkulacji. W tym celu geometria zostanie zmodyfikowana przez wydłużenie elementów walcowych o większej średnicy. W tym celu zostanie wykorzystane narzędzie wyciągania Pull.
[image: ]

· W zakładce Design wybierz Pull i za pomocą LPM kliknij zaznaczoną na pomarańczowo powierzchnię wlotową
[image: ]
· Następnie LPM chwyć zaznaczoną powierzchnię i przesuń w lewo. Pojawi się okno z wymiarem w mm. Wpisz tam 50 i zatwierdź klawiszem Enter
[image: ]
· W celu zakończenia edycji kliknij LPM w dowolnym miejscu na białym polu ekranu obok powierzchni modelu
[image: ]Kliknij LPM np. w tym miejscu

· Analogicznie wyciągnij powierzchnię wylotową. W przypadku popełnienia błędu wciśnij przycisk Cofnij w lewym górnym rogu ekranu [image: ]
[image: ]
· W celu wycentrowania widoku wybierz Design > Home lub wciśnij Shift + H
[image: ]
W analizowanym przypadku większość powierzchni ma proste kształty cylindryczne, na których łatwo jest wygenerować dobrej jakości siatkę numeryczną. Wyjątek w tym przypadku stanowi obszar gdzie krzyżują się dwa kanały:
[image: ]
W poprzednich ćwiczeniach były generowane siatki stanowiące połączenia siatki o elementach tetragonalnych i pryzmatycznych na ściankach. W tym ćwiczeniu zostanie wprowadzony kolejny typ siatki numerycznej: o elementach heksagonalnych. Wynikowa siatka numeryczna będzie się składała z obszarów o elementach heksagonalnych i tetragonalnych. Obszary te oznaczono na rysunku poniżej odpowiednio (1) i (2).
[image: ]2
1
1

· Najpierw należy podzielić geometrię na wskazane obszary przy pomocy narzędzia Split Body
· W zakładce Design wybierz Plane w celu utworzenia płaszczyzny tnącej
[image: ]
· Wybierz płaszczyznę wlotową – płaszczyzna jest utworzona
[image: ]
· Za pomocą narzędzia Design > Move przesuń płaszczyznę o 45 mm. W tym celu LPM przesuń niebieski wektor przesunięcia poziomego a następnie wpisz wartość 45 mm i zatwierdź Enter
[image: ]Wektor przesunięcia

· [bookmark: _GoBack]W zakładce Design wybierz metodę Split Body i wskaż całą bryłę a następnie utworzoną płaszczyznę jako płaszczyznę tnącą. W celu wyjścia z polecenia naciśnij klawisz Esc
[image: ]1) wskaż bryłę

[image: ]2) wskaż płaszczyznę i naciśnij Esc

· Wyłącz widoczność płaszczyzny
[image: ]
· Analogicznie postępuj dla płaszczyzny wylotowej z tą różnicą, że teraz odległość płaszczyzny tnącej wynosi 95 mm
[image: ]
· Po przecięciu bryły w drzewie systemowym powinny być 3 objętości
[image: ]
· W zakładce Workbench wybierz Share i przy wciśniętym klawiszu Ctrl wybierz zaznaczone powierzchnie
[image: ]
· W celu zatwierdzenia wybierz 
[image: ]
· Obiekty dzielące powierzchnie zaznaczone są w drzewie systemowym poprzez [image: ]
[image: ]
· Wyłącz płaszczyzny z dalszych obliczeń za pomocą Suppress for Physics
[image: ]

[image: ]
· Zapisz projekt i zamknij SpaceClaim.
5. [bookmark: _Toc3538734]Generowanie siatki numerycznej
· Otwórz program Ansys Meshing klikając dwukrotnie LPM na komórkę Mesh lub kliknij prawym przyciskiem myszy (PPM) a następnie wybierz Edit
[image: ]
· Na ekranie zobaczysz moduł Meshing z wcześniej przygotowaną geometrią
[image: ]
· W drzewku po lewej stronie kliknij LPM Mesh – pojawi się okno Details of Mesh
[image: ]
· W polu Physics Preference wybierz opcję CFD
[image: ]
· Wygeneruj siatkę numeryczną za pomocą przycisku [image: ] znajdującego się u góry ekranu. Jest to siatka automatyczna (generowana automatycznie przez program) o elementach heksagonalnych i tetragonalnych. 
[image: ]
· U dołu widoczna jest „linijka” pozwalająca oszacować rozmiary obiektu. Jednostka długości jest 1 m z układu SI, który jest układem domyślnym w Ansys Meshing. W celu zmiany układu jednostek wybierz w menu głównym Units
[image: ]
· W celu obejrzenia wygenerowanej siatki zastosuj wcześniej poznane metody ruchu w SpaceClaim
Kolejnym krokiem w generowaniu siatki numerycznej jest nadanie nazw powierzchniom. Nazwy te zostaną następnie wykorzystane przy ustawianiu warunków brzegowych podczas przygotowania symulacji numerycznej. W tym celu wykorzystuje się Named Selections.
· Z głównego paska menu wybierz filtr wyboru lic (face’ów)
[image: ]
· Kliknij LPM w zaznaczony poniżej na rysunku face A (zrobi się zielony)
[image: ]
· Kliknij PPM i wybierz Create Named Selection 
[image: ]
· Wpisz nazwę powierzchni jako inlet i naciśnij OK. Utworzona nazwa powierzchni pojawi się w drzewku systemowym pod Named Selections
[image: ]
· Wykonaj podobne czynności dla face B i nazwij ją outlet

· W celu nazwania całej bryły wybierz 
[image: ]
· Zaznacz całą bryłę (w celu wybrania kilku brył przytrzymaj klawisz Ctrl)
[image: ]
· Za pomocą Create Named Selection nadaj nazwę fluid_domain

[image: ]
· W Details of Mesh w polu Quality  wybierz Element Quality i sprawdź jakość wygenerowanej siatki
[image: ]
· W polu Statistics sprawdź ilość elementów siatki
[image: ]
· Zapisz projekt za pomocą File > Save Project
[image: ]
· i zamknij moduł Meshing za pomocą File > Close Meshing

6. [bookmark: _Toc3538735]Ustawienia symulacji numerycznej – preprocessing
· W Workbench w Component Syestems kliknij LPM na CFX
[image: ]
· Przy wciśniętym LPM przeciągnij moduł CFX na komórkę Mesh aż pojawi się czerwone pole Transfer A3
[image: ]



· Kliknij PPM na Mesh i wybierz Update. Ma to na celu wysłanie do programu CFX siatki numerycznej w odpowiednim formacie
[image: ]
· Ikona Mesh zmienia status na zaktualizowany. Kliknij dwukrotnie na Setup w celu przejścia do CFX – programu do przeprowadzania symulacji numerycznych CFD
[image: ]
· Otwiera się okno dialogowe Ansys CFX

[image: ]


· Kliknij dwukrotnie LPM na Default Domain w celu edycji domeny obliczeniowej
[image: ]
· W polu Location wybierz fluid_domain. Jest to nazwa, która została utworzona w module Meshing

[image: ]
· Płynem roboczym w tym ćwiczeniu jest woda, więc w polu Material wybierz Water

[image: ]

· Przejdź do zakładki Fluid Models i wybierz opcję Heat Transfer jako None w celu nie uwzględnienia wymiany ciepła oraz model k-Epsilon w celu zamodelowania turbulencji (przepływ w tym przypadku jest turbulentny). Zatwierdź przyciskiem OK.
[image: ]
· W celu ustawienia warunku brzegowego inlet wybierz ikonę [image: ]
[image: ]
· Wybierz następujące ustawienia dla inlet
[image: ]
[image: ]
· Podobnie utwórz warunek brzegowy na wylocie
outlet

[image: ]
[image: ]

Pozostałe powierzchnie, które nie zostały nazwane w CFX znajdują się w Default Domain Default.


· W polu Solver wybierz Solver Control
[image: ]
· W zakładce Basic Settings wybierz High Resolution dla Turbulence Numerics i ustaw minimalną i maksymalną liczbe iteracji na 1000000. Zatwierdź OK
[image: ]
· Kliknij ikonę tworzenia wyrażeń [image: ]
· Nadaj nazwę deltaP
[image: ]

· W polu Definition kliknij PPM, wybierz Functions > Locator-based > areaAve
[image: ]
· W nawiasie wpisz zmienną p (ciśnienie) 
[image: ]
· W polu Definition ustaw kursor za znakiem @, kliknij PPM, wybierz Physics Locators > 2D > outlet
[image: ]
· Kliknij Apply i zamknij expression [image: ]
· UWAGA: Celem utworzonego expression dp jest obliczanie w każdej iteracji spadku ciśnienia w kanale. Wyrażenie na spadek ciśnienia powinno być Δp = pinlet – poutlet. W Ansys CFX zmienna p to ciśnienie statyczne wzlgędne. Ponadto w warunku brzegowym outlet ustawione została wartość ciśnienia względnego jako 0, czyli poutlet = 0 Pa. W takim przypadku Δp = pinlet i dlatego zastosowano taki wzór na dp.
· W polu Solver kliknij dwukrotnie na Output Control w celu ustawienia punktu monitorującego
[image: ]
· W zakładce Monitor wybierz Monitor Objects > Insert Monitor i nadaj nazwę punktowi monitorującemu
[image: ]
· W polu Option wybierz Expression
[image: ]
· W polu Expression Value kliknij PPM, wybierz Expression i następnie nazwę expression, które utworzyłeś. Zatwierdź OK.
[image: ]
· Zapisz projekt [image: ] i zamknij CFX Pre
· W Workbench kliknij PPM na Solution i wybierz Update – rozpoczynają się obliczenia
[image: ]
· Kliknij PPM na Solution i wybierz Display Monitors
[image: ]
· Otwórz zakładkę User Points i zatrzymaj obliczenia przyciskiem [image: ] gdy wykres dp ustabilizuje się (około 10 minut na pojedynczym procesorze i7, około 1200 iteracji). Sprawdź także czy ustabilizowały się krzywe reziduł. Kliknij OK po zakończeniu obliczeń i wyłącz Solver. Taki czas obliczeń jest prawdopodobnie zbyt krótki i należałoby dalej prowadzić obliczenia do ustabilizowania krzywych reziduł i punktu (punktów monitorujących). Jednak na potrzeby ćwiczenia taka dokładność jest wystarczająca.
[image: ]
· W Workbench zapisz projekt i kliknij dwukrotnie LPM na Results w celu zobaczenia wyników w CFD Post
[image: ]

[bookmark: _Toc3538736]Lista zadań 3
Zad. 1
Pokaż rozkłady prędkości i ciśnień w płaszczyźnie symetrii kanału.
Zad. 2
Pokaż rozkłady wektorów prędkości w płaszczyźnie symetrii.
Zad. 3
Pokaż rozkłady linii prądu zaczynających się od powierzchni inlet.
Zad. 4
Sprawdź wartość wyrażenia: strumień masy na wlocie + strumień masy na wylocie. Obliczenia wykonaj w tabeli.
Zad. 5
Zagęść siatkę i wykonaj analogiczne obliczenia do ustabilizowania się linii punktu monitorującego i reziduł. Sprawdź jak zagęszczenie siatki wpłynęło na wyniki. 
W celu zagęszczenia siatki numerycznej zamknij moduł CFD Post, a następnie otwórz Meshing. W polu Details of Mesh > Defaults > Element Size zmień wartość domyślną na wartość 0,001 m. W celu zatwierdzenia nowej wartości naciśnij klawisz Enter. Zauważ, że pozostałe wielkości w polu Sizing zostały przeliczone automatycznie przez program. Wygeneruj nową siatkę za pomocą Mesh Update [image: ].
[image: ]
Następnie za pomocą PPM wybierz Setup oraz Update. Wykonaj obliczenia na nowej siatce numerycznej.
[image: ]
Zad. 6*
Dodaj Inflation do zagęszczonej siatki numerycznej i wykonaj analogiczne obliczenia do ustabilizowania się linii punktu monitorującego i reziduł. Sprawdź jak dalsze zagęszczenie siatki wpłynęło na wyniki. Co to jest Mesh independence study?

· W celu utworzenia Inflation kliknij LPM na Mesh w drzewie systemowym
 [image: ]
· Rozwiń pole Inflation i w polu Use Automatic Inflation wybierz Program Controlled
[image: ]
· Wybierz Mesh Update[image: ]
· W polu Details of Mesh w zakładce Quality w polu Mesh Metric wybierz Element Quality
[image: ]
· Sprawdź jakość siatki. Najgorsze elementy siatki mają wartości bliskie 0, najlepsze 1. Wygenerowana siatka ma minimalną Quality 0,072. Im lepsza jakość siatki tym dokładniejsze wyniki obliczeń. Generowanie Inflation zwykle pogarsza jakość siatki numerycznej, ale jest niezbędne w celu dokładnego obliczenia gradientów na ścianach.
 [image: ]
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